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K N I M E  E X P L O R E R  

INTRODUCTION 

The KNIME Explorer is a new feature of the open source KNIME Desktop application. It allows 
you to browse your workflows in the KNIME repositories and to act upon them (for example 
through the context menu) – just like the old KNIME project navigator. As with the traditional 
navigator you can look at the workflow projects that are stored in your current workspace but 
additionally, the new KNIME Explorer allows you to look at multiple workflow repositories at 
the same time thus enabling you to share workflows and collaborate with colleagues using 
shared resources. 

In the KNIME Explorer you can “mount” the workflow repositories you want to work with. You 
can mount multiple repositories at the same time allowing you to work on workflows from 
different repositories simultaneously and to copy or move workflows from one repository to 
another. 

By default only your current workspace is visible (mounted) in the explorer and depending on 
the product licenses you own, you can add TeamSpace repositories, which contain workflows 
stored on a local directory in the file system, or ServerSpace repositories, showing  workflows 
stored on a KNIME Server. Depending on the type of the repository the functionality that is 
available may differ (for example workflows on a server can’t be opened and directly modified).  

In this guide the new functionality that comes with the KNIME Explorer is shown – it assumes 
that you are familiar with the traditional way of working with workflows in the KNIME project 
navigator.  

INSTALLATION 

The KNIME Explorer view is already part of the KNIME Desktop application and no additional in-
stallation steps are required. In order to open this view, select from the “View” menu the 
“KNIME Explorer” item. Only one KNIME Explorer view can be open at a time. As of KNIME 
version 2.7. the Explorer view has replaced the Project Navigator in the default perspective for 
viewing workflow and data repositories. 

COMMON FEATURES 

 

ADDING REPOSITORIES 

By default only the LOCAL and the EXAMPLES workspaces are displayed in the Explorer view. 
The LOCAL workspace shows all workflows and groups of the current workspace like in the 
traditional KNIME Workflow Projects navigator. The EXAMPLES workspace provides access to 
the KNIME Public Server with its example workflows. 

If you want to add a workflow repository to the view, you need to register a new mount point. 
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MOUNT POINTS 

Workflow repositories that should be accessible from KNIME are called mount points. Mount 
points can be displayed in the KNIME Explorer view. 

Each mount point consists of the location of the workflow repository (that is either the path to 
the directory or the address of the server) and a “Mount ID”. 

New mount points are defined in a preference page: From the “File” menu, select “Preferences”, 
then select “KNIME Explorer” in the category “KNIME”.  

The KNIME Explorer preference page 
shows all currently defined mount points. 
The LOCAL workspace is included by 
default (which is the place where the 
KNIME base version stores the 
workflows). 

To link a new shared directory to the 
Team Space, click “New…”. 

 

In the dialog that opens, enter a mount ID and click OK to select the directory that should be 
mounted. 

The mount ID may only contain characters, numbers, 
dashes and dots. It is used to reference files or 
workflows located under the new mount point.  

Especially if workflows are shared and files are 
accessed throughout different mount points, it is 
important to associate the correct shared directory 
with the mount ID. If nodes in a workflow use an URL 
with the “knime” protocol to read from the shared 
space (see section below), it will always reference the 
same file, as long as the same shared directory is 
mounted. If a mount point is removed while a 

workflow node reads from a file stored in the mount point, the reading will fail. If a different 
shared directory is mounted with the same mount ID, all URL references will try to access the 
file in this different directory. If it doesn’t exist, the operation fails.  
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After you have added all mount points needed, you can 
put them in order by selecting one and clicking “Up” or 
“Down” to move it up or down in the list. The mount 
points are displayed in this order in the KNIME 
Explorer view. 

Important:  
When sharing Metanodes within a common mount 
point, all KNIME instances connected to this mount 
point need to use the same mount point ID. 

 

MOUNT TABLE 

The list of all defined mount points – that is the list of mount IDs with their associated shared 
directories – form the “mount table”. It is defined in the preference page (see above) and is saved 
automatically when KNIME is closed. When you export the preferences (menu “File” -> “Export 
Preferences…”), this table is exported with all other settings and if the preferences are imported 
into another KNIME workspace, the mount table is effectively transferred. 

If nodes in the workflow reference data files (or Metanodes) in a mounted repository, the 
references are resolved against the mount table (see section below).  This resolution is done by 
mount ID, so it is important to note that only IDs which are defined in the mount table can be 
resolved: if the mount ID is changed or lost in the mount table, a “file not found” error will 
appear.  

KNIME EXPLORER VIEW 

You can open the KNIME Explorer view, click the “View” menu and select “KNIME Explorer”. The 
Explorer opens and shows the registered KNIME work locations. Alternatively, you can select 
“View > Reset Perspective” to restore the default KNIME view which as of KNIME Desktop 2.6 
and displays the Explorer by default. 
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In order to add more content to the view, click the “configuration” icon( ). The selection dialog  
opens, showing all currently defined mount points: 

 

From the Select Mountpoints window you can choose which shared repositories that you want 
to see in your Explorer view.  Clicking “Configure Explorer Settings” you will be taken KNIME 
Preferences page mentioned in the previous section where you can add additional mount points. 

 

EXPLORER TOOLBAR 

At the top of the view are several GUI elements arranged in a toolbar: 

 

 

The (+) expands the selected element showing its content, while (-) collapses the 

element, hiding its children. The  collapses all elements in the view showing 
only the top level elements. 

 Refreshes the view, in case it is out-of-sync with the underlying file system. 

 
If a workflow located in the Team Space is shown in an editor, this workflow is 
selected in the Team Space view. 

Filter 
If you add text to the field and press Enter, the Explorer will filter to items that 
contain the text in their name or are in a group containing the text in its name. 

 
Opens the configuration dialog, allowing you to select the content displayed in 
the view or to add/remove mount points (as seen above). 
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KNIME EXPLORER CONTENT 

In addition to the repository entries we have discovered so far, 
there are four additional types of content that can be seen in the 
KNIME Repository.  These are described in the table below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Workflow A group of documents which describe a data manipulation process. 

 
Workflow 
Group 

A folder within the Explorer which can be used to store workflows, data files 
and metanode templates.  

 Data File 
Only data files with known extensions are shown. Data files can be dragged 
to a workflow editor or a workflow group.  File reader nodes can read data 
files stored in the TeamSpace (see section below). 

 
Metanode 
Templates 

Metanodes containing a pre-configured workflow fragment can be added to 
both TeamSpace and ServerSpace. Once added to a workflow, they can be 
easily updated if the original Metanode in the repository changes. 
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CONTEXT MENU 

If you right-click in the view or on an item of the view, the following menu is shown. Several 
menu items are disabled, depending on whether they are applicable to the selected item or not. 

 

 

 

 

 

 

 

 

 

 

Creates a new and empty workflow, places it in 
the selected workflow group (or directory) and 
opens it in a workflow editor. 

Creates a workflow group. 

Opens the Workflow import or export wizard. 

Deletes or renames the selected item. If a 
workflow is currently edited by a user, or a 
workflow group contains a open workflow, it is 
locked and can’t be renamed nor deleted. 

Opens the configuration dialog on the selected 
workflow or executes the entire workflow. Only 
enabled on workflows opened in an editor. 

Opens the corresponding dialog allowing you to 
define workflow variables or credentials on the 
selected workflow. 

Opens the Meta Information editor allowing 
entering information and a description 
associated with the selected workflow or 
workflow group. 

Copies the URL or Local Path of the selected 
item to the clipboard, i.e. for direct access to this 
source via system explorer or a terminal. 
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EXPLORER OPERATIONS 

Move To move an item, simply drag it and drop it on the desired new 
location. You can move within the same mount point or move items 
between different shared resources.  Additionally, Ctrl-c and Ctrl-v 
can be use to copy workflows between repositories.  

Copy Copying an item is the same process than moving it – just keep the 
“Ctrl”-key pressed during the drag & drop step. A little plus-sign next 
to the mouse cursor indicates the copy operation. The same 
restrictions with respect to what can be copied where apply. 

Node Creation If a data file of a supported type is dropped into the workflow editor, 
KNIME will add the data file to your workflow using the appropriate 
file reading node.  

Metanode 
Template 
creation 

You can save a Metanode Template to your Teamspace or 
ServerSpace repositories for later re-use. To do this, simply right-click 
on any Metanode and select “Save as Metanode Template…”.  The 
resulting dialog will let you choose a destination for your new 
Template. (More details can be found in the corresponding section 
below.) 

Metanode 
Template 
usage 

To use a Metanode stored in the TeamSpace, drag&drop it in the 
workflow editor. A linked Metanode is added to the workbench. This 
instance is updated either manually through the context menu or 
when the workflow is loaded. The Metanode can also be unlinked 
from the TeamSpace which makes it editable in the workflow directly. 
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ENTERPRISE FEATURES (TEAMSPACE AND SERVER) 

KNIME Teamspace and KNIME ServerSpace are commercial features of the KNIME product 
family.  KNIME Teamspace facilitates the use of KNIME Desktop in small groups by allowing you 
to share your workflows and data files easily between KNIME desktop applications using shared 
repositories that may contain workflows, data files and meta-nodes.  KNIME ServerSpace has 
some additional features.  Specifically, in addition to having access to a shared repository, the 
ServerSpace enables server-side execution of workflows, user access permissions and the ability 
to run workflows via the KNIME Webportal.   

PREREQUISITES 

The KNIME TeamSpace V3.0 and KNIME ServerSpace V3.6 requires a KNIME Desktop V2.5.4 or 
higher. 

INSTALLING KNIME TEAMSPACE FEATURES 

Start KNIME as the user that owns the installation directory. From the “Help” menu, select 
“Install New Software…”. Click “Add…” and “Archive…” in the following dialog. Browse to the 
Team Space update site archive from the KNIME Team Space distribution. Select the KNIME.com 
TeamSpace Extensions (including the KNIME TeamSpace and KNIME Report Batch Execution), 
click “Next”, accept the license and finish the installation. The new feature will only be available 
after a restart of KNIME. 

INSTALLING KNIME SERVERSPACE FEATURES 

Start KNIME as the user that owns the installation directory. From the “Help” menu, select 
“Install New Software…”. Click “Add…” and “Archive…” in the following dialog. Browse to the 
KNIME.com ServerSpace update site. Select the KNIME.com Client Side Extensions and click 
“Next”, verify the licensing terms and finish the installation. The new feature will only be 
available after a restart of KNIME. 

LICENSES 

The TeamSpace only works with a valid license file. Create a directory named “licenses” in your 
KNIME installation directory, if it doesn’t exist already. Copy your license file from the KNIME 
Team Space distribution to this directory. Finally, restart KNIME in order to activate your 
license. 

If you don’t have a license file, or it is not working correctly, please contact KNIME by sending an 
email to contact@knime.com or to your dedicated KNIME support specialist. You can check your 
license using the KNIME License view available in the menu View > Other… > KNIME Views. 

If you get the error message “No license found.”, please check the name of the license directory, 
it must be named “licenses”, and be located in the KNIME installation directory. Finally, the 
license file must end with “.xml” and have read permissions for the user running KNIME. 

Licensing for the KNIME ServerSpace is controlled on the server itself.  If you do not know your 
username and password, please contact your local KNIME system administrator. 
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DATA FILES IN REMOTE REPOSITORIES 

Files can be stored in workflow groups together with workflows in both KNIME TeamSpace and 
KNIME ServerSpace repositories. Add a file to a remote repository using by dragging it from a 
file explorer window (the “Windows Explorer” in Windows) to the desired group within the 
repostiory. Only files with registered extension are accepted by the KNIME Explorer.  

You can also copy a file with the operating system to the mounted shared directory. After you 

click refresh  in the TeamSpace explorer, the file is displayed. Note again that as above, only 
files with a registered extension are visible. 

 

DROPPING FILES IN THE WORKFLOW EDITOR 

Files stored in a remote repository can be dragged to an open workflow editor. The node that is 
associated with the file’s extension is instantiated and configured to read from the dropped file. 
If the node is not executable – that is, it needs more settings in its dialog – the configuration 
dialog will be opened. Registered file extensions and their associated reader nodes are fixed and 
cannot be adjusted by the user. 

TEAMSPACE URL-SCHEME 

References to files located in a remote repository use a URL.  Both TeamSpace and ServerSpace 
features define a new URL scheme (“knime”), which denotes a resolution to the KNIME Explorer.  
If you use the “knime” URL scheme, it must refer to the same mount point regardless of the 
operating system or the mounted content. When a data file is dropped into a KNIME workflow, 
the instantiated Reader is automatically configured to read from the knime-URL. 

The general syntax of a URL referencing a data files in a KNIME repository is: 

knime://<mount-ID>/<path in repository>/<filename> 

The scheme (the first element in the URL) must always 
be “knime:”. After the first slash, specify the mount ID of 
the content you want to read from. Subsequently, the 
path to the file in the repository including the filename 
is used to locate the file of interest.  

As long as you and your colleagues are using the same 
mount ID for your shared repository, you will be able to 
easily reference share a single repository and 
workflows that are moved from system to system will 
always be able to see the original data, enabling 

seamless data sharing that is truly independent of the operating system KNIME is running on 
and makes it easier to share workflows among different users and different computers. 
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METANODE TEMPLATES IN REMOTE REPOSITORIES 

TeamSpace and ServerSpace repositories can be used to store reusable Metanodes. Metanodes 
stored in a remote repository allow complicated subroutines in KNIME to be shared among your 
colleagues. This enables increased productivity through a reduced duplication of efforts and by 
allowing fixes and improvements to these subroutines to be pushed out to all users of a 
particular Metanode. 

Metanodes stored in workflow groups in the TeamSpace. They are displayed with this icon:  

USING METANODE TEMPLATES 

To use a Metanode from your remote repository, simply drag it to the workflow editor, which 
will then insert a linked metanode reference. The advantaged of a linked reference is that it can 
be used to update your working copy of the node should the original be changed. A Metanode 
linked to a shared repository is read-only, but can be unlinked from its metanode template via 
the metanode context menu command: “Disconnect Meta Node Link”.  

 

Metanodes in a workflow with an arrow in the lower left corner of the node icon  are „linked“ 
Metanodes. 

LINKED METANODES 

Linked metanodes are read-only instantiations of a metanode template. If you open the editor 
for this new metanode copy (by double-clicking it for example), the editor has a gray 
background, indicating that it is indeed read-only: you may open the configuration dialogs on the 
nodes and inspect the settings but you may not apply changes to configuration dialogs or adjust 
node inputs or outputs. 

If you open the context menu on a metanode and select 
“Update Meta Node Link”, KNIME will check if the original 
metanode template has changed since the copy in the 
workflow was last updated. If an update is available, you may 
choose to overwrite your local copy. If you choose to not 
update, the link icon in the node will change from green to 
red. The red arrow serves as a reminder that the template has 
changed and that the metanode is currently not in sync with 
those changes. 
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WORKFLOW LOADING WITH LINKED METANODES 

Upon loading a workflow containing one or more linked Metanodes, KNIME will ask if you would 
like to check for newer versions of your linked Metanodes.  Choosing yes will allow you to see 
which nodes have available updates and give you the opportunity to implement those updates in 
your current workflow.  Choosing No will simply flag all of your nodes as potentially outdated 
and allow you to proceed with your analysis normally.  You will subsequently need to manually 
update your Metanode links when this becomes convenient.  

DISCONNECTING LINKED METANODES 

Should you need to edit your linked metanode you will first need to disconnect it from its linked 
template.  From the context menu of the node select “Disconnect Meta Node Link”. The little link 
arrow in the node’s icon will disappear. 

You can now edit the metanode and save changes. It is a regular metanode now. You cannot 
automatically check for new versions of the original template anymore. You can in turn use this 
modified metanode to create a new metanode template or override an existing one, see section 
below. 

CREATING A METANODE TEMPLATE 

Any metanode in a workflow can become a metanode template when it is stored in the 
TeamSpace.  

Be careful to create the subflow contained in the metanode in a way so that it will work in other 
workflows and in other KNIME environments. For example, try to avoid hard coded paths to files 
or directories.  Instead, use URLs that reference files in the remote repository using the scheme 
identified in the previous section.  All nodes should be pre-configured to run with the expected 
data input this step is very important because linked metanodes are read-only for their users. 

In streamline the adoption of your metanodes, consider adding detailed custom node 
descriptions.  From the context menu select: “Edit Node Description…”.  Your node description 
should contain information regarding the purpose of your node, the configuration options that 
you have exposed (see nex section), and details regarding expected inputs and outputs. You may 
also change the name of the node. This is what users see, when they connect to the TeamSpace. 
Note that it is not advised to use non-standard characters: stick with numbers, spaces and 
underscores in order to avoid problems. 

Finally, you may right-click on your Metanode and select “Save as Metanode Template…”. The 
resulting dialog will prompt you to choose a location where to save the Metanode template.  
After creating the template in the Team Space another dialog opens. You can now add a link from 
the Metanode in your workflow to the newly created template in the Team Space. This way you 
can update your local copy of the Metanode whenever the template in the TeamSpace is 
updated. 

USING QUICKFORM NODES IN METANODE TEMPLATES 

Linked Metanodes are read-only instances spawned from a template in a remote repository. 
They cannot be changed or configured by the end user.  However, in order to provide some 
degree of flexibility in Metanode templates it is possible to parameterize them using QuickForm 
nodes. When the template contains QuickForm nodes the metanode will construct a 
configuration dialog based off of the defined these nodes. For more information on this topic, 
please refer to the KNIME WebPortal documentation.   
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SERVER SPACE FEATURES 

TEAMSPACE VS SERVERSPACE 

The behavior of workflows in the different types of remote repositories (KNIME TeamSpace and 
KNIME ServerSpace) will be briefly outlined here.   

In a nutshell, Teamspace provides a shared resource where workflows may be executed locally:  

  

A serverspace enables user access permissions, server-side execution, and scheduling for more 
complex environments:  

 

If a workflow is opened by one user, it is locked for all other users; actually it is locked for all 
other KNIME instances, i.e. the same user can’t open it with another KNIME instance either. The 
workflow cannot be opened or modified by any other user while it is in use by one user. Also the 
workflow groups that contain it cannot be modified, i.e. not renamed or deleted nor moved or 
copied. 

 

 

 

 

 

A workflow not opened by this KNIME 
instance. 
The workflow is not fully executed. 

All nodes in the workflow are executed. 

The workflow is currently executing. 

A remote workflow on a KNIME Server 

A workflow job scheduled for execution 

A successfully executed remote workflow 

A workflow scheduled for periodic execution 
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EXECUTING A WORKFLOW ON THE SERVER 

If “Execute…” is selected from the context menu of a workflow, the following dialog appears: 

  

 

If you click OK, the workflow is loaded into the KNIME executor on the server. 

 

It is possible to schedule the workflow for delayed and even periodic execution. If “Schedule 

Execution” is checked additional scheduling options appear that allow you to set a date and time 

when the workflow should be executed. To enable periodic execution, check the “Repeat” box 

and enter an interval to be used between subsequent executions. 

Scheduled jobs are children of their corresponding workflow in the server's repository. While 
non-repeating scheduled jobs are automatically removed from the time table after their 
execution, repeating jobs exist until they are deleted by the user.  

 

 

 

Email notification settings: enter one or 
multiple email addresses to which a 
notification is sent after the workflow 
execution has been finished; this is 
independent from the state of the workflow.  

If the workflow has a a report attached, the 
Server Workflow Remote Execution window 
shows the different report output formats 
including PDF, XLS, PPT, DOC, and PS. 

If checked, the workflow is reset before it is 
executed. All nodes are reset (also File 
Reader and Database Reader nodes, etc.).  

 
If selected, the executed workflow instance 
(“Workflow Job”) is deleted after successful 
execution, without saving it. 

 

The name of the workflow job as it is 
displayed in the server view. If the default is 
accepted, the execution date and time is 
appended. 

 
If selected, the flow is not executed 
immediately but at the date and time set.  

 
If “Repeat” is selected enter the time between 

the subsequent executions of the flow. 
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If the flow contains nodes that require credentials (user name and password) for them to log in 
to another system (for example Database Nodes), these credentials are usually stored as 
workflow credentials and the following dialog allows entering the credentials for this run: 

 

Select the credentials you want to change and click “Edit” to enter username and password. 

If the workflow contains flow variables, a dialog shows, allowing you to enter new values for 
these variables:   

 

Select the variable you want to change, click “Edit” and enter the new value. After you click OK in 

this dialog, the execution starts. 

Executing workflows are displayed as “Workflow Jobs” in the server view. They show as children 
of their workflow with a decorator indicating their status. A flow can be executed 
simultaneously multiple times, creating multiple workflow jobs. 

  

 

Please note, with multiple KNIME instances for flow execution, one of the limited number of 
KNIME instances is blocked as long as the job stays in memory. Consider checking “discard after 

execute” (especially with repeating scheduled jobs) in order to remove jobs that successfully 

executed and to free a KNIME resource. 

 

 

 

 

A currently executing flow. 

A scheduled workflow job (executing 
once at the specified time). 

A flow scheduled for periodic execution. 
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WORKFLOW JOB STATUS 

 

  

 

 

Workflow Jobs stay in the main memory of the server after execution (unless you checked 
“discard after execution”) until you remove them manually. Right-click on the icon of the 

workflow job to open the context-menu: 

 

 

The result of the workflow job can currently only be inspected by saving it as workflow in the 
repository – this can also be achieved by dragging & dropping it into a different location inside 
the server repository - and then downloading that flow to your local workspace and opening it 
there. Currently it is not possible to download the workflow job directly. 

If the server is not configured to run multiple KNIME executor instances (see section above), a 
flow is executed on the server under the same user Glassfish was started with. If it writes to a 
file, this user must have write permissions at the destination location. If the flow submits jobs 
into a cluster (separate KNIME Cluster Execution plug-in) they are submitted by this user. 

Workflow jobs are children of their corres-
ponding workflow in the server’s repository. 

A successfully executed job: all nodes are 
executed. The flow stays in memory until it is 
removed manually through the context menu.  

This job is currently executing in the KNIME 
executor on the server. The date and time it 
started is added to its (default) name. 

Scheduled jobs (scheduled for single and 
periodic execution).  

This workflow job finished unsuccessfully. An 
error occurred. The yellow warning icon 
indicates node messages. They can be looked 
at through the context menu. 

Cancels workflow job execution (only 
available if the job is still executing). 

Deletes the workflow job from the memory 
of the server (this does not affect the 
workflow in the server’s repository this job 
was generated from). All data is lost, if the 
flow was not saved before. 

Shows the messages that occurred in the 
workflow. Only available if a yellow 
warning icon shows at the workflow job. 

Saves the workflow job as workflow in the 
server’s repository. (Only available if you 
have “read”/”download” access to the 
original workflow.) 
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USER ACCESS PERMISSIONS 

You can assign access permissions to each server item (workflows or workflow groups) to 
control the access of other users to your workflows and groups.  

THE OWNER 

The server stores the owner of each server item, which is the user that created the item. When 
you upload a flow, save a workflow job (an executed flow) or create a new workflow group you 
are assigned to the new item as owner. When a new server item is created, you can set the 
permissions how you want this item to be available to other users. Later on, only the owner can 
change permissions on an item. 

USER GROUPS 

When the KNIME Server administrator defines the users that have access to the KNIME Server, 
the users are assigned to groups. Groups can be defined as needed – for example one group per 
department, or per research group, etc. Each user must be in at least one group, and could be in 
many groups. 

There is a predefined special group called “admin”. Users assigned to that group are considered 
Server Administrator. 

SERVER ADMINISTRATOR 

A user that is assigned to the group “admin” is considered a Server Administrator. 
Administrators are not restricted by any access permissions. Administrators always have the 
right to perform any action usually controlled by user access rights. They can always change the 
owner of an item, change the permissions of an item, see all workflow jobs (while regular users 
only see their own jobs) and they can delete all jobs and items. 

WORKFLOW GROUP PERMISSIONS 

Read Allows the user to see the content of the workflow group. All workflows 
and subgroups are shown in the repository view. 

Write If granted, the user can create new items in this workflow group. One can 
create new sub-groups and can store new workflows in the group. Also 
deletion of the group is permitted. 

 

Note: In order to access a workflow it is not necessary to have read-permissions in the workflow 
group the flow is contained in. Only the listing of contained flows is controlled by the read-right. 
Also, a flow can be deleted without the write-right in a group (if the corresponding right on the 
flow is granted). 

Also, in order to add a flow to a certain group, you only need the permission to write to that 
particular group, not to any parent group. 
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WORKFLOW USER PERMISSIONS 

Execute Allows the user to execute the flow, to create a workflow job from it. It 
does not include the right to download that job, or even store the job after 
it finishes (storing requires the right to download).  

Write If granted, the user can overwrite and delete the workflow.  

Read Allows the user to download the workflow (including all data stored in 
the flow) to its local desktop repository and inspect the flow freely. 

Note: Executing or downloading a flow does not require the right to read in the group that 
contains the flow. In fact, there is currently no right controlling the visibility of a single flow 
(there is no hidden attribute). 

ACCESS TO WORKFLOW JOBS AND SCHEDULED JOBS 

There are no permissions to be set on a workflow job or a scheduled job. Only the owner – the 
user that created the job – can see the job in the repository view, and he/she is the only user that 
can delete it. 

In order to store a workflow job as new workflow in the server’s repository, the user needs the 
right to download the original workflow (the flow, the job was created from). This behavior 
prevents an unauthorized user from downloading a workflow by executing it and downloading 
the resulting job. 

“OWNER”, “GROUP”, AND “OTHER” RIGHTS 

As the owner of a server repository object (workflow, workflow group or file), you may grant 
workflow permissions to other users using the group level tools. Permissions for individual 
users other than the owner are not available. 

OWNER RIGHTS 

The owner can assign permissions to himself to protect a flow from accidental deletion. He can 
change his own permissions at any time.  

NOTE: The owner can also assign a new owner to a server item – pulling away his right of making 
any further changes to the access permissions of this item! 

GROUP RIGHTS 

The owner of a server item can assign permissions to all users of a specific group. If an access 
right is granted to a group, all users that are in this group have this right. 

“OTHER” RIGHTS 

Permissions can be set to all users that are not the owner and that are not in one of the groups. 

NOTE: Access rights are cumulative and can’t be withdrawn – for example, if you grant the right 
to execute a flow to “other” users and you define permissions for a certain group of users not 
including the execute right, these users of that group are still able to execute that flow, as they 
have obtained that right through the “other” permission settings.  
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SETTING/INSPECTING ACCESS PERMISSIONS 

When a new server item is created, you can assign it access rights through the “Server Workflow 
Access Permissions” dialog. If multiple new groups are created with one step, the specified 
permissions are applied to all groups created. 

At any time, the owner can change the permissions from the context menu of the server item, 
and all other users can inspect the permissions through this dialog: 

  

Add group permissions in this dialog: 

 

 

Only groups in the list on the left hand side have permissions granted. Select any group to 
change the permissions on; Add this group to apply those changes. 

 

Only administrators can change the 
owner of the server item. Note: Enter 
the exact name. No spell checking is 
done. Note: Only the new owner (and 
administrators) can change permissions 
from then on. 

Grant access rights to you here.  

If you want to set group permissions, 
click here to open the “Group 
Permissions” dialog. 

Each checkmark grants a right to 
“other” users that are not in one of the 
groups. 

Enter the name of the group you want to 
grant access rights. Note: Enter the 
exact name, no spell checking is done. 

Each checkmark grants the 
corresponding right to all users of the 
group. 
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SETTING PERMISSIONS RECURSIVELY 

In the permissions dialog of workflow groups, there is the option (at the bottom of the dialog) to 
apply the permissions to the selected group and all elements contained in that group. If you 
select this option and click OK, the permissions that apply are set on all groups and flows on 

which you have the right to change the permissions (i.e. the elements you are the owner of). 
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